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REVISION HISTORY

REVISION DESCRIPTION DATE

1.0 First Release Oct 09

Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof nor
for the rights of third parties, which may be effected in any way by the use thereof. Any representations in this document concerning
performance of Evertz products are for informational use only and are not warranties of future performance, either express or implied. The only
warranty offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order confirmation
form.

Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no
warranty is granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or
order confirmation. Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions. If
you encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make
changes in equipment design or specifications.
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1. OVERVIEW

As broadcasters, cable companies, satellite providers and IPTV companies are moving to a all digital
domain, all distribution is done in the compressed domain. These service providers have a need for a
versatile, easy to use, cost effective pro video decoder.

The 7880DEC-MP2HD-2 is a professional high quality MPEG-2 SD and HD decoder card. It offers
high end SD and HD decoding of two signals coming from 2 ASI inputs. The 7880DEC-MP2HD-2 is
perfect for monitoring applications or decoding for downstream baseband video and audio processing.

The 7880DEC-MP2HD-2 can reconstruct in the most flexible way all VANC & HANC data in the
HD/SDI output.

The front end of the 7880DEC-MP2HD-2 includes advanced ASI input monitor. The 7880DEC-
MP2HD-2 offers 2 ASI inputs to feed 2 independent decoders. The 7880DEC-MP2HD-2 can be
coupled with Evertz RF front end (7780DM2-LB DVB-S2 demodulator) and Evertz downstream video
and audio processing equipment to create a complete versatile integrated receiver/decoder.

Features
o 2xSD or HD 422 Video Decoder (422 Optional)
ASI dual inputs on each decoder
Selection of decoded service
(HD) SDI with embedded audio and ancillary data
Monitoring of ASI inputs
Fully integrated with the industry leading VistaLINKg PRO system
Built-in frame controller for control

Revision 1.0 7880DEC-MP2HD-2 -1
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Figure 1-1: 7880DEC-MP2HD-2 Block Diagram

7880DEC-MP2HD-2 -2 Revision 1.0



7800 MultiFrame Manual
7880DEC-MP2HD-2 Dual HD MPEG-2 Decoder

everlilz

2.

INSTALLATION

2.1. REAR PLATE DESCRIPTION

The 7880DEC-MP2HD-2 comes standard with a companion +3RU rear plate. Figure 2-1 provides an
illustration of the 7880DEC-MP2HD-2 rear plate. For information on mounting the rear plate and
inserting the module into the frame, see section 3 of the 7700FR manual.
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Figure 2-1: 7880DEC-MP2HD-2 Rear Plate

2.1.1. Decoder Connections

HD/SDI PROG OUT: Two BNC connectors, one for each decoder. They are used to output main

decoded HD/SD-SDI video signals.
HD/SDI MON OUT: Two BNC connectors, one for each decoder. They are used to output
backup/monitored HD/SD-SDI video signal.
ASI INPUT: Two BNC connectors, one for each decoder. They are used to input ASI
MPEG2 Transport Streams.

7880DEC-MP2HD-2 -3
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ASI OUTPUT: Two BNC connectors, one for each decoder. They are used to bypass given
ASI Transport Streams.

2.1.2. Ethernet Connection

The 7880DEC-MP2HD-2 Series uses 10Base-T (10 Mbps), 100Base-TX (100 Mbps) or Gigabit
(1Gbps) twisted pair Ethernet cabling systems. When connecting for 10Base-T systems, category 3, 4,
or 5 UTP cable as well as EIA/TIA — 568 100Q2 STP cable may be used. When connecting for
100Base-TX systems, category 5 UTP cable is required. The cable must be “straight-through” with an
RJ-45 connector at each end. Establish the network connection by plugging one end of the cable into
the RJ-45 receptacle of the card and the other end into a port of the supporting hub.

The straight-through RJ-45 cable can be purchased or can be constructed using the pin-out
information in Table 2-1. A colour coded wiring table is provided in Table 2-1 for the current RJ-45
standards (AT&T 258A or EIA/TIA 258B colour coding shown). Also refer to the notes following the
table for additional wiring guide information.

: : AT&T 258A or 10BaseT
Pin Pin# | Signal EIAITIA 568A EIA/TIA 5688 or 100BaseT
—_— 1 Transmit + White/Green White/Orange X
uugggugg 2 Transmit — Green/White or White Orange/White or Orange X
R 3 Receive + White/Orange White/Green X
HEH RN 4 N/A Blue/White or Blue Blue/White or Blue Not used (required)
5 N/A White/Blue White/Blue Not used (required)
I:I 6 Receive — | Orange/White or Orange Green/White or Green X
| | 7 N/A White/Brown White/Brown Not used (required)
8 N/A Brown/White or Brown Brown/White or Brown Not used (required)

Table 2-1: Standard RJ-45 Wiring Colour Codes

Note the following cabling information for this wiring guide:

e Only two pairs of wires are used in the 8-pin RJ-45 connector to carry Ethernet signals.

¢ Even though pins 4, 5, 7 and 8 are not used, it is mandatory that they be present in the cable.

e 10BaseT and 100BaseT use the same pins (a crossover cable made for one will also work with the
other).

e Pairs may be solid colours and not have a stripe.

e Category 5 cable must use Category 5 rated connectors.

The maximum cable run between the router and the supporting hub is 300 ft (90 m). The maximum
combined cable run between any two end points (i.e. router and PC/laptop via network hub) is 675 feet
(205 m).

Devices on the Ethernet network continually monitor the receive data path for activity as a means of
checking that the link is working correctly. When the network is idle, the devices also send a link test
signal to one another to verify link integrity. The rear panel is fitted with two LEDs to monitor the
Ethernet connection.

1000: This Amber LED is ON when a 100Base-TX link is last detected. The LED is OFF when a
10Base-T link is last detected (the LINK LED is ON). Upon power-up the LED is OFF as
the last detected rate is not known and therefore defaults to the 10Base-T state until rate
detection is completed.

7880DEC-MP2HD-2 -4 Revision 1.0
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LN/ACT: This dual purpose Green LED indicates that the card has established a valid linkage to its
hub, and whether the module is sending or receiving data. This LED will be ON when the
module has established a good link to its supporting hub. This gives you a good indication

that the segment is wired correctly. The LED will BLINK when the module is sending or
receiving data. The LED will be OFF if there is no valid connection.

2.2. HARDWARE INSTALLATION
To successfully install the 7880DEC-MP2HD-2:

1. Unused IP address on the network or a DHCP server.
2. Evertz serial cable.
3. VLPro Server IP address.

Before handling the card it is important to minimize the potential effects of static electricity. It is
therefore recommended that an ESD strap be worn. Locate on a 7700 chassis three adjacent vacant
slots. Unpack the 7880DEC-MP2HD-2 and separate the rear panel from the main card. Locate on the
rear of the rack the three slots and remove the blanking panels. Insert the rear panel into the back of
the chassis and secure using the six screws provided.

o o Po PO PO po po

SEALAL LD

[z | everiz | sverilz | everiz | everiz | everilz | everiz | everiz

FUSES:
o o o] =] o) o o o] 3 E T4ALZSOV

Figure 2-2: 7700 Chassis and 7880DEC-MP2HD-2 Rear Panel

Before inserting the front card, connect the serial cable to the board using the serial cable provided.
Now insert the 7880DEC-MP2HD-2 card into the corresponding front slots ensuring the card lines up
with the slot runners on the bottom and the top of the chassis. Push the card into the slot ensuring that
when it mates with the rear card that is has been firmly pushed into a seated position. This can be
confirmed when the connectivity lights for the Ethernet port are illuminated. Do not connect any cables
to the rear card (failure to do this could cause unwanted network issues) until the initial configuration
has been completed.

Revision 1.0 7880DEC-MP2HD-2 -5
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Restore Defaults
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Figure 2-3: COM Port Properties Window

Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal
session and configure the port for the following configuration:

Click OK to apply these settings and press the return key. The

Bits per second | 115200
Data Bits 8
Parity None
Stop Bits 2

Flow Control None

7880DEC-MP2HD-2 Main Menu as shown in Figure 2-4:

session

should respond with the

De & 3

@ Evertz - HyperTerminal
File Edit Wiew Call Transfer Help

DB &

BE) ]

Starting PCI

Restart Monitoring.....
Restart Honitoring.....
Starting Initialize SNMP agen
no preset found - SNMP Pkt 29f1950
Starting Initialize Decoder
Starting FPGA Interrupt
Starting FTPd

7780TSM FAMILY SOFTWARE
Version 1.0.0 Build 472 Date:

[ OK 1

Sat Oct 27 17:56:07 20087

[ OK 1

[ OK 1
[ OK 1
[ OK 1]

Main Menu
{ 7880DEC-MP2HD-2 1.0.0)

L ——
> CAF~WNI= |
o e |

Network Configuration
SNMP Configuration

Setup Decoder Parameters
Utilities
Engineering/Debug

Exit

Al

Connected 0:00:39

ANSTW 115200 8-N-2

&
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Figure 2-4: HyperTerminal Main Menu

(1) Network Configuration
This sub-menu enables the user to configure the network settings for the card.

(2) SNMP Configuration

This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community
strings.

(3) Setup Decoder Parameters
This sub-menu is used to configure the decoder parameters. As this configuration can also be
performed via VLPro this sub-menu will not be covered in this section.

(4) Utilities
This sub-menu contains two utilities. One command is for clearing the memory, and the other for
clearing the flash. In normal operation it should not be necessary to use either of these options.

(5) Engineering/Debug
This menu is for Evertz personnel only. You may be requested to access and execute options within
this menu when seeking technical support from Evertz. Guidance will be given should this be required.

Before is it possible to configure the card via VLPro it is first necessary to configure the initial basic
network settings via the serial cable. Refer to section 2.3.

2.3. CONFIGURING THE BASIC NETWORK SETTINGS

Now select option (1) Network Configuration, the Network Configuration menu will be displayed as
shown in Figure 2-5. If you prefer to use DHCP then you may select option (5) Use DHCP, and then
continue from step 4:

1. Select option (1) Set IP Address and configure the IP address for the 7880DEC-MP2HD-2

ensuring that the IP address is not already in use on the network.

2. Now select option (2) Set Netmask and configure the correct subnet mask for your network.

3. If required also configure option (3) Set Gateway.

4. Exit from the Network Configuration menu using (s) Save and Exit, NOT (x) EXxit.

Revision 1.0 7880DEC-MP2HD-2 -7
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Network Configuration

i (7830DEC-MP2HD-2 1.0.0)

ENET: 1 MAC: 00:02:c5:00:3a:19

ip address: 192.168.11.70
netmask address: 255.255.255.0
gateway: 192.168.11.1

broadcast address: 192.168.11.255

DHCP enabled: False

} Set IP Address

) Set Netmask

) Set Gateway

) Set Broadcast Address

) Use DHCP

) Configure Second Ethernet Port
) Configure Routing Table

)
)

XKW ~JONNF~WRN

Save and Exit
Exit

(V=

3 | 12
Connected 0;01:31 ANSIW 115200 8-N-2 NUM

Figure 2-5: Network Configuration Sub-Menu

From the Main Menu select option (2) SNMP Configuration. Select option (1) Set IP Address and enter
the IP address of your VLPro Server. Exit using option (S) Save and Exit, now extract the card from the
rack, remove the serial cable and re-insert it.

You have now completed the necessary minimum configuration and can connect the cables to the rear
card when ready.

2.4. CONNECTING TO VLPRO

This chapter assumes that the VLPro server and VLPro client are already configured for your network
and you have basic knowledge of the VLPro interface. It also assumes that the user or network
administrator has already added the 7880DEC-MP2HD-2 jar file to the server and both the client and
server applications have been restarted. If you are the network administrator refer to section 6.2 for
information on updating the VLPro Server Jar File.

Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” symbol.
Your 7880DEC-MP2HD-2 should appear as a newly listed device with the IP address used to configure
the card in Step 1 above. It may take up to a minute to appear while the card and switch negotiate
network settings (this can be verified directly on the switch if necessary).

7880DEC-MP2HD-2 -8 Revision 1.0
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Listed below the 7880DEC-MP2HD-2 will be two inputs numbered one and two.

= VistalLINK PRO - 192.168.50.182 Q@@

File  Tree Alarm  Configuration  Audit Preset Tools  Window  Help

e g Ay o |ve: By R, Oy

X 1182.168.50.182, 1 380DEC-MP2HD-2: Configuratio B
F |retrest @ &2 [ 1.0 || 2ooty By By
ks Input 59|901\'l Program Tuning \\. Program Info ‘1\ Cutputs ‘1\ General ‘1\ Misc Faults ‘\'SNMP Conﬂguration‘l\
[}...E
=8| rinput Select - Decoder 1
----- = Decoder Input Select (3 ASlInput1 (O ASHInput 2 O OF
rinput Select - Decoder 2
R
- Decoder Input Select ) ASlInput1 (3 ASI Input 2 (O OF
- rinput Mode Select
Input 1 Stream Mode |aTsc ~|
168.50.162 SR Input 2 Stream Mode |aTsc ~|
...... -
...... -t
[}..9

Figure 2-6: VistaLINKg PRO Hardware Configuration

Note: If after a couple of minutes the card has still not appeared try selecting
Add Agent from the Tree> Add/Update Agent menu. Enter the IP address used
g in the configuration stage earlier and select OK. The card should now be listed

and will remain greyed out for a moment while VLPro finds the card and
confirms its configuration.

Please consult your network administrator if you continue to have problems connecting the card with
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support.
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3. CARD CONFIGURATION

Right click the IP address of the 7880DEC-MP2HD-2 and select “View Configuration”. The
configuration page will open; it is from these configuration tabs that the 7880DEC-MP2HD-2 can be
configured. Refer to the relevant section of this manual for an explanation of the features and functions.

3.1. INPUT SELECT

The input selection tab is used to select the input in use. Both inputs are bypass protected, thus in the
event of the card failing, being removed or the power being cut off, the loop-through for the ASI will
continue. The decoded output will no longer be available.

NOTE: If the card is removed from the chassis, the ASI loop through will continue
,@f but the decoded output will no longer be available.

=
|Refr\esh @ @ 1.0 |J”13F'|3‘ -;}' @;’;&

Input SEIECT\\I Program Tuning \'. Programm Info ‘I! Qutputs \'. General \'. Misc Faults \'. SHNMP Configuration \'.

rinput Select - Decoder 1
Decoder Input Select (&) ASl Input 1 () AS Input 2 () OF

rinput Select - Decoder 2

Decoder Input Select () ASl Input1 O ASHnput 2 O Off
rinput Mode Select

Input 1 Stream Mode [Dva v]

Input 2 Stream Mode |ATsC -|

Figure 3-1 VistaLINKg PRO — Input Select

e Input Select: The decoder card has two ASI inputs. Select here the input you require.

NOTE: The decoder has two ASI inputs; the card is a single decoder and is only
,@ able to decode one program from either of the two inputs.

e Input Mode Select:
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0 Input Stream Mode: The Input Stream Mode options available are ATSC, DVB and
MPEG. It is important to select the standard to which the stream is being coded as this
affects the context of the alarms for ETSI TR 101 290 priority 3 and the handling of AC3

Audio.

3.2. PROGRAM TUNING

|Refnesh & &0 |ﬂpplv B2,

Input Selact’ Program Tuning \ Program Info \ Outputs \ General \ Misc Faults \ SMMP Configuration \

rProgram Tuning - Decoder 1

Frogram Tuning Mode ’Program Select

]

Auto Program Select Mode

Select Pragram:

Program Mumber |1802

| [ewist_~]

Wideo Pid Mumber

FPCR Pid Mumber

Audio Service 1 Pid Mumber

Audio Service 2 Pid Number

Audio Service 3 Pid Number

Audio Service 4 Pid Mumber

Wiew List

1801

Wideo Playout Type FTS

rProgram Tuning - Decoder 2

Frogram Tuning Mode

Program Mumber
Wideo Pid Mumber
FPCR Pid Mumber
Audio Service 1 Pid Number
Audio Service 2 Pid Number
Audio Service 3 Pid Number
Audio Service 4 Pid Number

Wideo Playout Type

’Auto

]

Auto Program Select Mode ’F\rst Program In PAT

'] Select Program:

P13

Figure 3-2 VistaLINKg PRO — Program Tuning

3.2.1. Program Tuning

e Program Tuning Mode: Options are Auto, Program Select or PID Select.
0 Selection of Auto will set the decoder to decode either the first program in the PAT or the
lowest program number; this can be selected using the next configuration option below.
o0 Program select allows the user to define the program number, PCR, video and audio
selection is automatic based upon the PMT.
o PID Select allows the user to define the PCR, Video and up to four audio by their PID
numbers. The PMT PID is ignored.

e Auto Program Select Mode: Options are First Program in PAT or Lowest Program Number.
o0 First program indicates the first program defined within the PAT.
0 Lowest program number will select the program with the lowest Program ID.

e Program Number: When the Program Tuning mode is set to Program Select, enter in this field
the Program ID in decimal form.

&5

that you wish to tune into.

Note: You may use the Select Program drop down menu to select the program
The drop down menu will be automatically populated
with the program numbers available in the incoming stream.

Revision 1.0
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Select Frogram:

\viewlList |
prewlist =
301
302
303
304
305
306 —
307 B

Figure 3-3: Select Program Drop Down List

e Video PID Number: When the Program Tuning mode is set to PID Select, enter in this field the
Video PID ID in decimal form.

e PCR PID Number: When the Program Tuning mode is set to PID Select, enter in this field the
PCR PID ID in decimal form.

e Audio Service 1 PID Number: When the Program Tuning mode is set to PID Select, enter in
this field the first Audio PID ID in decimal form.

e Audio Service 2 PID Number: When the Program Tuning mode is set to PID Select, enter in
this field the second Audio PID ID in decimal form.

e Audio Service 3 PID Number: When the Program Tuning mode is set to PID Select, enter in
this field the third Audio PID ID in decimal form.

e Audio Service 4 PID Number: When the Program Tuning mode is set to PID Select, enter in
this field the forth Audio PID ID in decimal form.

e Video Playout Type: This field determines the type of video playout. The Playout type options

are PTS (Presentation Time Stamp) or VBV (Video Buffering Verifier), but default PTS will
be selected.

NOTE: When Program Tuning Mode is set to PID Select, it is possible to select any
,@5 audio from any service with the transport stream.
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3.3. PROGRAM INFO

|Refnesh @ @ 1.0 |PPP|V l/’ @,ﬁ

Input Select‘l\ Frogram Tuning 1 Frogram Info \l Qutputs ‘1\ General ‘1\ Misc Faults ‘1\ ShMP Configuration ‘1\

rDecoder 1 rDecoder 2

rProgram Monitor rVideo Monitor rProgram Monitor rVideo Monitor
Frogram Mum In TS 1801 Video PID Mumber 1639 Frogram Num In TS 1 Video PID Mumber 17
FMT FID 1640 Wideo Bitrate (Mbis) 2.841 FMT FID 16 Wideno Bitrate (Mb/s) 17.133
FCR FID 1639 Yideo Resolution 1920x1088 FCRPID 17 Wideo Resolution 1920x1088
Mum Video Streams 1 Wideo Profile And Level MPE@HL Murm Video Streams 1 Widea Profile And Level MPEHL
MNum Audio Streams 1 video Chroma Format 420 MNum Audio Streams 1 Yideo Chroma Format 420

rAudio 1 Monitor rAudio 2 Monit rAudio 1 Monitor rAudio 2 Monitor
FID Mumber 1638 PID Mumber FID Mumber 20 PID Mumber
Bitrate (Khis) 150.264 Bitrate (Khfs) Bitrate (khis) 422470 Bitrate (khis)
Audio Type AC-3 audio Audio Type Audio Type AC-3 audio Audio Type
Sampling Rate 48kHz Sampling Rate Sampling Rate 48KkHz Sampling Rate

MNum Channels MNum Channels MNum Channels MNurm Channels

32 5-Ch. Surround (L+C+R+LS+RS) 32 5-Ch. Surround (L+C+R+LS+RS)

rAudio 3 Monitor rAudio 4 Monitor rAudio 3 Monitor rAudio 4 Monitor

FID Mumber PID Mumber FID Mumber FID Mumber

Bitrate {Khi=) Bitrate {khis) Bitrate {Kbi=) Bitrate {Khi=)

Audio Type Audio Type Audio Type Audio Type

Sampling Rate Sampling Rate Sampling Rate Sampling Rate

MNum Channels Mum Channels MNum Channels MNum Channels

Figure 3-4: VistaLINKg PRO — Program Info

3.3.1. Program Monitor

e Program Number in TS: The currently decoded Program ID is displayed here in decimal form.

e PMT PID: The currently decoded Program Map Table Packet ID is displayed here in decimal
form.

e PCR PID: The Program Clock Reference Packet ID is displayed here in decimal form.
¢ Num Video Streams: The number of video streams within the program is displayed here.

e Num Audio Streams: The number of audio streams within the program is displayed here.

7880DEC-MP2HD-2 - 13
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3.3.2.

3.3.3.

Video Monitor

Video PID Number: The currently decoded Video Packet ID is displayed here in Decimal form.

Video Bitrate: The current video bitrate is displayed here; this value will be variable for video
encoded in VBR.

Video Resolution: The currently decoded video resolution will be displayed here; this is read
from the PSIP/PSI.

Video Profile and Level: The currently decoded video profile will be displayed here; this is read
from the PSIP/PSI. This will either be MP@ML or MP@HL.

Video Chroma Format: The currently decoded video resolution will be displayed here; this is
read from the PSIP/PSI. This will either be 4:2:0 or 4:2:2.

Audio 1/2/3/4 Monitor
PID Number: The currently decoded Audio Packet ID is displayed here in Decimal form.
Bitrate: The current Audio bitrate is displayed here.

Audio Type: The currently decoded video resolution will be displayed here; this is read from the
PSIP/PSI.

Sampling Rate: The currently decoded Audio Sampling rate will be displayed here; this is read
from the PSIP/PSI.

Num Channels: The number of channels of Audio in the currently decoded program will be
displayed here; this is read from the PSIP/PSI.
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.’u :
Input Select | Program Tuning |, Pragram Info” Qutputs || General | Misc Faults | SNMP Configuration |
rDecoder 1 rDecoder

rMisc Control rMisc Control
Output video Mods (&) Continuous ) Discontinuous Output Video Mace (&) Continuous () Discontinuous
Output Standard ’Native VI Output Standard ’Native VI
Cutput Wideo Color ’Ellack '] Cutput ¥ideo Color ’Ellack ']
CCEO8 Embed (5) Disable () Enable CCEOS Embed (%) Disable () Enable
CCEO8 Embed Line Number =7 1 g CCE08 Embed Line Mumber o} 1 g
CCT08 Embed (%) Digahle () Enable CCY08 Embed (%) Digahle () Enable
CC708 Embed Line Mumber =7} 1y CC708 Embed Line Mumber 9
video Delay 33 ! 0 Frames video Delay = ! 0 Frames

rEmbedding Audio Source rEmbedding Audio Source
Group 1 AES 1 |Audio 1 ~| Group 1 AES 1 |Audio 1 ~|
Group 1 AES 2 ’Audio 2 VI Group 1 AES 2 ’Audio 2 VI
Group 2 AES 3 ’AudiUS '] Group 2 AES 3 ’Audiu3 ']
Group 2 AES 4 | Audtio 4 -] Graup 2 AES 4 | Audto 4 -]

rEmbedding Audio Delay rEmbedding Audio Delay
Group 1 AES 1 (6 ' 0ms Group 1 AES 1 (. ' Oms
Group 1 AES 2 33 ' 0ms Group 1 AES 2 = ' Oms
Group 2 AES 3 (E. ' 0 Group 2 AES 3 E ' O
Graup 2 AES 4 (6 ! 0me Group 2 AES 4 7l ! 0me

rAC3 Decoders Assig it rAC3 Decoders A
AC-3 Decoder 1 ’Group 1 AES 1 VI AC-3 Decader 1 ’Group1 AES 1 VI
AC-3 Decoder 2 ’Group 1AES 2 '] AC-3 Decoder 2 ’Groum AES 2 ']

Figure 3-5 VistaLINKg PRO - Outputs

3.4.1. AC3 Decoder Assignments

e AC3 Decoder 1/2: The 7880DEC-MP2HD-2 can decode two AC3 streams per input. AC3 can
be set for decode or bypass onto the outbound SDI. The selection can be made for AC3
assignment, Groupl AES1/2 and Group2 AES1/2. The professional stereo mix is preformed
when decoding. The original AC3 feed is embedded to video when bypass is selected.

3.4.2.

o Group 1/2/3/4: The 7880DEC-MP2HD-2 automatically embeds the selected audio streams into
the outgoing SDI. Here it is possible to re-arrange the audio streams and/or embed other
separate audio streams. Simply select for each Group, which Audio should be embedded.

Embedding Audio Source

7880DEC-MP2HD-2 - 15
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3.4.3. Embedding Audio Delay
e Group 1/2/3/4. The 7880DEC-MP2HD-2 card automatically embeds the selected audio streams
into the outgoing SDI. It is possible to add an additional delay to synchronize the audio and

video stream. Simply slide the audio delay to the desired setting for each audio group. The
maximum delay is 500ms.

3.4.4. Misc. Control

¢ Output Video Mode: Options are continuous or discontinuous. When in continuous mode and
the user switches between inputs, the output will not be dropped between sources, the output is
thus continuous. In discontinuous mode the output, when switching between inputs, will drop
momentarily.

e Output Standard: Options are Native, 525i/59.94, 625i/50, 720p/59.94, 1080i/59.94 and
1080i/50.

o Output Video Colour: Options are Black or Blue, this is the colour that will be output when the
input is lost.

NOTE: Using Blue is a good compliment to the Evertz MVP/VIP systems, which by
,@ default, use Green to signify loss of the input. Thus a blue screen will indicate a
loss of source at the encoder, not at the MVP/VIP.

e (CC608 Embed: This allows the user to decide if Closed Caption 608 should be embedded on
the output, by default this is disabled.

e (CC608 Embed Line Number: This allows the user to select the line at which the closed
captions will be embedded; the range is line 7 to 21.

e (CC708 Embed: This allows the user to decide if Closed Caption 708 should be embedded on
the output, by default this is disabled.

e CC708 Embed Line Number: This allows the user to select the line at which the closed
captions will be embedded; the range is line 7 to 21.
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3.5.

'What are "native 608" closed captions?

CEA-608 ("native 608") closed captions are captions formatted and presented in the
current analog television system and carried on the two fields of line 21 of the vertical
blanking interval. Field one contains CC1, CC2, T1, and T2 (the latter being text services).
Field 2 contains CC3, CC4, T3, and T4. CC1 is most often used to carry verbatim English
captions and CC3 is increasingly being used for Spanish-language captions and captions
edited for young children ("Easy Reader" or "Beginning Reader" captions). The common
look and feel of native 608 captions is limited to white block letters within a box-like black
background field. Colour (non-white) characters, while possible, are only occasionally
used due to the 13-year legacy of set-top decoders, which cannot display coloured
captions.

'What are "native 708" closed captions?

CEA-708B is the standard for conveying caption data in a digital television signal.
Because the DTV signal does not have a vertical blanking interval, CEA-708B specifies
that the captioning data shall be carried in the video user bits of the MPEG-2 bitstream.
CEA-708B captions have greatly enhanced formatting and display capabilities compared
to NTSC 608 captions. Strictly speaking, native 708 captions are those authored and
encoded for CEA-708B use. It is also possible to encode native 708 format captioning
from authoring information intended for 608 captioning, although such captions will have
the same limitations as translated captions.

GENERAL

This tab is for information only; it displays the type of card that is installed in the chassis. The card also
has the ability to monitor the power supplies of the frame in which it resides in. Simply check the
Frame Status Error box to enable SNMP traps. The Frame Trap Status LED is an indicator that will
turn red when one or both of the frame’s power supplies fail.

s |

|Refresh @ @ 1.0 |J”13'I?'|!nr @; m;_

Input Select\ FProgram Tuning \ Prograrm Info \ Qutputs * General \l\ Mizc Faults \ SHMP Conﬂguratinn\

Misc Monitor

CPLD Version 4

FTER0DEC-MP2HD-2

Figure 3-6 VistaLINKg PRO - General

Revision 1.0 7880DEC-MP2HD-2 - 17



7800 MultiFrame Manual r
7880DEC-MP2HD-2 Dual HD MPEG-2 Decoder ever Z>

3.6. MISC FAULTS

=
|Refr\esh @ @ 1.0 |J°PF'|3‘ !j @j_

Input Select‘\ Prograrn Tuning \'. Prograrm Info \". Cutputs \". General Misc Faults \'. ShIMP Configuration ‘\

rDecoder 1
Trap Enable rTrap Status
Yideo Output O Wideo Output
Closed Caption Presence | Closed Caption Presence
rDecoder 2
Trap Enable rTrap Status
Yideno Output | Wideo Output
Closed Caption Presence O Closed Caption Presence
rFrame Trap Enable rFrame Trap Status
Frame Status Errar | Frame Status Errar

Figure 3-7 VistaLINKg PRO — Misc Faults

3.6.1. Trap Status

e Video Output: The status of the video output trap is shown in this field; when video is being
output the LED will be green.

o Closed Caption Presence: The status of the video output trap is shown in this field; when
Closed Caption video is being output the LED will be green.

3.6.2. Trap Enable
e Video Output: The Video Output trap in the output trap can be enabled / disabled in this field.

e Closed Caption Presence: The Closed Caption embedding in the output trap can be enabled /
disabled here.
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3.7. SNMP CONFIGURATION

fE E

=
Retrech @ @ | 1.0 20y By By

Input Select\ Frogram Tuning \". Program Info \". Cutputs \". General \". Mizc Faulis® SMMP Canfiguration \".

rAdd Trap Destination
Destination IP Address | |

rCurremnt Trap Destinations

Trap Destinations Remaove
1 1010102

2 10.10.10.222

Figure 3-8: VistaLINKg PRO — SNMP Configuration

3.7.1. Add Trap Destination

The SNMP destination can be added from VLPro interface in this field. Enter the IP address of the
computer with VLPro Server and click the Apply button. The IP address will be transferred to the
Current Trap Destinations section.

3.7.2. Current Trap Destinations

The Current Trap Destinations field displays SNMP destination addresses configured on card.
Identical SNMP notification will be sent to each location. Each destination can be removed by
selecting the remove button beside the trap you wish to remove and then clicking the Apply button.
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4. CONFIGURING INPUTS

4.1. INPUT MONITOR

'm 192168.11.21, Input [1]: Configuratian
|Fetresh @ @9 [ 1.0||spty By B,

Input Monitor\TS Syntax Errors - P1 & P2 \TS Syntax Errors - P3 ‘1\ Pid Monitor\Template Check\ Fault Control \Trigger Faults ‘1\

rInput Monitor rinput Control
Input State Inactive Input Stream hode DvE
Mum Programs 1] FID Display Mode |Decima| v|
Input Bitrate 0.000 Mhis TSID Display Mode | Decimal -
Netwark ID 0 Clear All Stats [cancel -
Metwork Name TiA Clear All Errors |Cance| v|

Figure 4-1 VistaLINKg PRO — Input Monitor

4.1.1. Input Monitor

e Input State: Displays either Active or Inactive, this field displays the state of the current input
(either input 1 or input 2).

e Num Programs: This indicates the number of programs present within the stream; this is read
from the PSIP / PSI in the stream.

e Input Bitrate: This indicates the gross bitrate of the input in bits/s.
e Network ID: This indicates, in decimals, the Network ID. This is read from the PSIP / PSl in the
stream.

o Network Name: This indicates the Network Name of the stream, if present. This is read from
the PSIP / PSI in the stream.

4.1.2. Input Control

e Input Stream Mode: Options available are ATSC, DVB and MPEG.
o0 Itis important to select the standard to which the stream is being coded as this affects
the context of the alarms for ETSI TR 101 290 priority 3 and the handling of AC3 Audio.

e PID Display Mode: Options are Hex or Decimal. This determines how the PID Monitor View
displays the PID value.

o Clear All Stats: Select enable, and then apply the change. All statistics will be reset.

o Clear All Errors: Select enable, and then apply the change. All error conditions will be reset.

7880DEC-MP2HD-2 - 20 Revision 1.0



everlz 7800 MultiFrame Manual
® 7880DEC-MP2HD-2 Dual HD MPEG-2 Decoder

42. TS SYNTAX ERRORS -P1 & P2

This tab displays a general health check of the most important elements of the TS. The tests are not
exhaustive and are outlined, in detail, in the document Digital Video Broadcasting (DVB); Measurement
guidelines for DVB systems ETSI TR 101 290.

.W. 192168.11.21, Input [1]: Configuration =
|Retresh @ @[ 1.0] sonv By By

Input Monitor TS Syntax Errors - P1 & P2 | TS Syntax Errors - P3| Pid Monitor | Template Check | Fault Gontral | Trigger Faults

P1 Necessary For Decoding

TestList Status Count Fault Monitor Threshold Cur. Repetition  Max Read
TS Sync Error ] 1 [F] 1 1] 1]
Sync Byte = a [F1 1 1] 1]
PAT Error ] 1 [F] 500 0 0
Continuity Count = a [F1 1 1] 1]
PMT Errar ] 1 [F] 500 0 0
PID Error = a [F a 1]
Clear P1 Errar |Camce|7V|

P2 Recommended

TestList Status Count  FaultMonitor Threshold — Cur. Repetition  Max Read
Transpart Error = a [F 1 1] 1]
CRC Errar = 0 [F] 1 0 0
PCR Repetition = a [F a i]
FCR Error = 0 il 0 0
PTS Error = a [F a 1]
CAT Errar [ 1 7] [ o ] 0 0
Clear P2 Error |Cance|7'|

MNOTE: PCR Error Threshold values are measured in ng. All other Threshold values are measured in ms

Figure 4-2 VistaLINKg PRO - TS Syntax Errors P1 & P2

For each test there is a Fault Monitor check box. Selecting this check box will update the Input
Configuration Tab - Syntax Error status and enable the alarm. The highest alarm severity will prevail.
When selecting the check box be sure to select, from the drop down box, the corresponding severity
that should be associated with this alarm.
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4.2.1.

4.2.2.

P1 Necessary for Decoding

TS sync_loss: The most important function for the evaluation of data from the MPEG-2 TS is
the sync acquisition. The actual synchronization of the TS depends on the number of correct
sync bytes necessary for the device to synchronize; two or more consecutive corrupted sync
bytes indicate sync loss. After synchronization has been achieved the evaluation of the other
parameters is carried out.

Sync_byte_error: The indicator "Sync_byte _error" is set as soon as the correct sync byte
(0x47) does not appear after 188 or 204 bytes. This is fundamental because this structure is
used throughout the channel encoder and decoder chains for synchronization. It is also
important that every sync byte is checked for correctness since encoders do not necessarily
check the sync byte.

PAT error: The Program Association Table (PAT), which only appears in PID 0x0000 packets,
tells the decoder what programs are in the TS and points to the Program Map Tables (PMT)
which in turn point to the component video, audio and data streams that make up the program.
If the PAT is missing then the decoder can do nothing, no program is decodable. Nothing other
than a PAT should be contained in a PID 0x0000.

Continuity_count_error: For this indicator three checks are combined. The preconditions
"Incorrect packet order" and "Lost packet" could cause problems for receivers that are not
equipped with additional buffer storage and intelligence. It is not necessary for the test
equipment to distinguish between these two preconditions as they are logically OR-ed, together
with the third precondition, "a packet occurs more than twice" into one indicator.

PMT _error: The Program Association Table (PAT) tells the decoder how many programs there
are in the stream and points to the PMTs that contain the information where the parts for any
given event can be found. Parts in this context are the video stream (normally one), the audio
streams and the data stream (e.g. Teletext). Without a PMT the corresponding program is not
decodable.

PID_error: Itis checked whether there exists a data stream for each PID that occurs. This error
often occurs where TS are multiplexed, or demultiplexed and again remultiplexed.

P2 Recommended

Transport_error: The primary Transport_error indicator is Boolean which counts the erroneous
TS packets. This counter is intended for statistical evaluation of the errors. If an error occurs, no
further error indication should be derived from the erroneous packet.

CRC _error: The CRC check for the CAT, PAT, PMT, NIT, EIT, BAT, SDT and TOT indicates
whether the content of the corresponding table is corrupted. In this case no further error
indication should be derived from the content of the corresponding table.

PCR_error: The PCRs are used to re-generate the local 27 MHz system clock. If the PCR
does not arrive with sufficient regularity then this clock may jitter or drift. The PCR discontinuity
of more than 100 ms occurring without specific indication or the time interval between two
consecutive PCR values is more than 40 ms.
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PCR_repetition_error: The PCRs are used to re-generate the local 27 MHz system clock. If
the PCR do not arrive with sufficient regularity then this clock may jitter or drift. The
receiver/decoder may even go out of lock. This error indicates that the time interval between two
consecutive PCR values is more than 40 ms.

PCR_discontinuity_indicator_error: The PCR_discontinuity_indicator_error is set in the case
that a discontinuity of the PCR values occurs that has not been signalled appropriately by the
discontinuity indicator.

PCR_accuracy_error: The accuracy of £500 ns is intended to be sufficient for the colour sub-
carrier to be synthesized from the system clock. This test should only be performed on a
constant bitrate TS as defined in ISO/IEC 13818-1.

PTS_error: The Presentation Time Stamps (PTS) should occur at least every 700 ms. The PTS
is only accessible if the TS is not scrambled.

CAT _error: The CAT is the pointer to enable the receiver to find the EMMs associated with the
CA system(s) that it uses. If the CAT is not present, the receiver is not able to receive
management messages.
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4.3. TS SYNTAX ERRORS - P3

.W. 192168.11.21, Input [1]: Configuratio
|Retresh @ @[ 1.0] sonv By By

Input Monitor\TS Syntax Errors - P1 & P2 ] Syntax Errors - P3 \ Pid Monitor‘l\TempIate Check\ Fault Contral \Trigger Faults ‘l\
P3 DVB Tables
TestList Status Count Fault Monitor Threshold Cur. Repetition  Max Read
NIT Repatition = 1 il 0 0
MIT Error = a [F1 lII a 1]
Unreferenced PID = a [F] III a 1]
SDT Repetition ] 1 [F1 a i]
SOT Error o 0 7] [ o ] 0 0
EIT Repetition ] 1 [F a i]
EIT Error = 0 il [ o ] 0 0
RET Repetition = a [F lII a i]
RST Error o 0 7] [ o ] 0 0
TOT Repetition ] 1 [F a i]
TOT Error o 0 7] [ o ] 0 0

P3 ATSC Tables
TestList Status Count  FaultMonitor Threshold — Cur. Repetition  Max Read
MET Repetition = a a i]
TWCT Repetition = a a 1]
CYCT Repetition = a a i]
EIT Repetition = a a 1]
RRT Repetition = a a i]
STT Repetition = a a 1]

P3 Clear Error Control
Clear P3 Errar |Cance|7'|

Figure 4-3: VistaLINKg PRO — TS Syntax Errors P3

4.3.1. P3DVB Tables

o NIT_Repetition_error: This test checks that any two sections with table_id = 0x40 (NIT_actual)
occur on PID 0x0010 within a 25 ms.

e NIT error: Network Information Tables (NITs) as defined by DVB contain information on
frequency, code rates, modulation, and polarization etc. of various programs that the decoder
can use. It is checked whether NITs are present in the TS and whether they have the correct
PID. The test checks that sections with table _id 0x40 or 0x41 in PID value 0x0010 occur at least
every 10 s.
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Unreferenced_PID: Each non-private program data stream should have its PID listed in the
PMTs. This test detects the presence of a PID (other than PAT, CAT, CAT_PIDs, PMT_PIDs,
NIT_PID, SDT_PID, TDT_PID, EIT_PID, RST_PID, reserved_for_future_use PIDs, or PIDs user
defined as private data streams) not referred to by a PMT within 0.5 s

Sl_repetition_error: For Sl tables a maximum and minimum periodicity are specified in EN 300
468 [7] and TR 101 211 [8]. This indicator should be set in addition to other indicators of
repetition errors for specific tables.

SDT_error: The SDT describes the services available to the viewer. It is split into sub-tables
containing details of the contents of the current TS (mandatory) and other TS (optional). Without
the SDT, the IRD is unable to give the viewer a list of what services are available. It is also
possible to transmit a BAT on the same PID, which groups services into "bouquets".

SDT_Repetition_error: This test checks that the SDT information which describes the services
contained in a particular Transport Stream is transmitted at least every 2 seconds on PID
0x0011.

EIT error: The EIT (Event Information Table) describes what is on now and next on each
service, and optionally details the complete programming schedule. The EIT is divided into
several sub-tables, with only the "present and following" information for the current TS being
mandatory. The EIT schedule information is only accessible if the TS is not scrambled.

RST_Repetition_error: This test checks that any two sections with table_id = 0x71 (RST)
occur on PID 0x0013 within 25 ms (or lower).

RST_error: The RST is a quick updating mechanism for the status information carried in the
EIT.

TDT_Repetition_error: This test checks that any two sections with table_id = 0x70 (TDT) occur
on PID 0x0014 within 25 ms.

TDT _error: Sections with table_id = 0x70 (TDT) not present on PID 0x0014 for more than 30 s.
The TDT carries the current UTC time and date information.

More information can be found at: http://www.etsi.org/

4.3.2.

P3 ATSC Tables

MGT Repetition: Master Guide Table. For each type of PSIP tables, the MGT provides the
location in the Transport stream, the current version of the table and the length in bytes. This
test checks that the Master Guide Table repetition rates do not exceed 150ms.

TVCT Repetition: Terrestrial Virtual Channel Table. Consists of virtual channel definitions
where each channel is characterized by the two-part channel number that the user will use to
access the service, its text name, how the service is physically delivered, its MPEG-2
program_number, its “source ID” and the type of service. This test checks that the Terrestrial
Virtual Channel Table repetition rates do not exceed 400ms.
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CVCT Repetition: Cable Virtual Channel Table. Consists of virtual channel definitions where
each channel is characterized by the two-part channel number that the user will use to access
the service, its text name, how the service is physically delivered, its MPEG-2 program_number,
its “source ID” and the type of service. This test checks that the Cable Virtual Channel Table
repetition rates do not exceed 400ms.

EIT Repetition: The PSIP table that carries program schedule information for each virtual
channel, this test checks the following is true:

0 EIT-0 Once every 0.5 seconds

0 EIT-1 Once every three seconds

o EIT-2 and EIT-3 Once every minute

RRT Repetition: Rating Region Table. Defines a rating system for a given region characterized
by a number of rating dimensions, each of which is composed of two or more rating levels. This
test checks that the Rating Region Table repetition rates do not exceed 60,000ms.

STT Repetition: System Time Table. Provides a reference for the time-of-day to receivers. This
test checks that the System Time Table repetition rates do not exceed 1000ms

More information can be found at: http://www.atsc.org

4.3.3. ETSITR 101 290 Test Conditions

The status LED located to the left of each test will highlight, when in Auto-Refresh, the dynamic status
of the stream.

For the majority of the ETSI TR 101 290 test it is possible to configure custom configurations to ensure
that particular alarms and conditions are fed back to the operator. It is important to select the Monitor
Enable check box (to enable custom monitoring parameters to be invoked), select the desired alarm
Severity and then configure the test Threshold.

‘ )/ NOTE: Syntax Errors P1, P2 & P3 are measured in ms. PCR Errors are measured

in ns.
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4.4. TR 101 290 DVB REFERENCE VALUES

Test DVB

TS sync loss

Sync_byte error B |
PAT _error
Continuity _count_error

PMT _error 500ms

PID _error 500ms

Transport_error

CRC error

PCR _repetition_error 40ms

PCR_error 500ns

PTS error 700ms

CAT eror )

Table 4-1: TR101 290 DVB Reference Values

4.5. PID MONITOR (+MON OPTION)

The PID Monitor tab is where VLPro displays the standard Transport Stream parameters. As shown in
Figure 4-4, it is possible to see all the packets within the TS stream. They are organized in ascending
order by Service ID but can also be re-ordered by Prog #. This can be done by double clicking the
column header, make sure you are not in the auto refresh mode when doing this.
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Figure 4-4 VistaLINKg PRO — PID Monitor

B 192168.11.21, Input [2]: Configuration =
|Rafnesh & &1 |ppp|y B B,
Input Monitor |, T3 Syntax Errars - P1 & P2 | T8 Syntax Errors - 3 Pid Momtor\Template Check | Fault Control |, Trigger Faults |,
Prog.# | Prog.Mame| PID# | PIDType | Tablever. |  Info | BarGraph | Bitrate(Mhps)|Min Bitrate.[Min Threshol.| Max Bitrate. [Max Thresho..| Bitrate Limit
1] FPAT 1 FAT I 0.026 0.024 0.0o0 0.026 100.000 1M LIMIT
16 MNIT 13 MIT I 0.002 0.001 0.0o0 0.002 100.000 1N LIMIT
17 50T 1 S0DT I 0.0048 0.003 0.0o0 0.006 100,000 1IN LIMIT
20 TOTTOT A TOTTOT I 0.0o0 0.000 0.0o0 0.002 100,000 1IN LIMIT
8191 MULL Packet A NULL Packet _ 5247 5214 0.0o0 5.3749 100,000 1IN LIMIT
30 CCTY-1 257 PWMT :PGM301 1 PMT :PGM301 I 0.024 0.024 0.000 0.026 100.000 1M LIMIT
30 CCTY-1 512 MPEG-2 Yideo [HrA MPEG2 Vide... 5.5858 2.053 0.000 6.141 100.000 1M LIMIT
30 CCTY-1 E50 MPEG-2 Audio [iA Unknown I 0132 0131 0.000 0.134 100.000 I LIMIT
302 CCTV-2 258 FMT :PGM302 1 PMTZPGM302I 0.024 0.024 0.000 0.026 100.000 1M LIMIT
302 CCTY-2 513 MPEG-2 Yideo [HiA MPEG2 Yide - 2470 2470 o.00o 5 BRS 100.000 1M LIMIT
302 CCTV-2 BEO MPEG-2 Audio A Unknown I 0132 013 0.0o0 0134 100.000 1M LIMIT
303 CCTV-7 2549 PMT PGM303 1 PMTZPGM3U3I 0.026 0.024 0.0o0 0.026 100.000 1M LIMIT
303 CCTV-7 514 MPEG-2 Video A MPEGQVidE..._ 4.033 2.038 0.0o0 B.020 100,000 1IN LIMIT
303 CCTV-7 670 MPEG-2 Audio A Unknown I 0131 013 0.0o0 0134 100,000 1IN LIMIT
304 CCTV-10 260 PMT :PGW304 1 PMTZPGM3U4I 0.026 0.024 0.0o0 0.026 100,000 1IN LIMIT
304 CCTW-10 415 MPEG-2 Video IR MPEGEVIUE...- 3.026 2533 0.000 B.OV7 100.000 1M LIMIT
304 CCTW-10 680 MPEG-2 Audio [HrA Linknown I 0132 0131 0.000 0134 100.000 1M LIMIT
305 CCTW-11 261 PMT :PGM305 1 PMTZPGMSUSI 0.026 0.024 0.000 0.026 100.000 I LIMIT
305 CCTV-11 516 MPEG-2 Yideo [HEA MPEGQVidE..._ 5.504 4726 0.000 B.141 100.000 1M LIMIT
305 CCTV-11 690 MPEG-2 Audio A Lnknown I 0131 0131 0.000 0.134 100.000 1M LIMIT
306 CCTV-12 262 FMT PGM30G 1 PMTZPGM3USI 0.026 0.024 0.0o0 0.026 100.000 1M LIMIT
306 CCTV-12 217 MPEG-2 Yideo A MPEGQVidE..._ 4.784 2,769 0.0o0 B.137 100.000 1M LIMIT
306 CCTV-12 oo MPEG-2 Audio A Unknown I 0132 013 0.0o0 0134 100.000 1N LIMIT
307 CCTV-MUSIC 263 FMT PGM30T 1 PMTZPGM:}UTI 0.026 0.024 0.0o0 0.026 100,000 1IN LIMIT
307 CCTV-MUSIC 518 MPEG-2 Video A MPEGZ Yide.. N .21 2113 0.0o0 5.851 100,000 1IN LIMIT
307 CCTV-MUSIC 710 MPEG-2 Audio A Layer Il | 48 ... 0.264 0.260 0.0o0 0.264 100,000 1IN LIMIT
307 CCTY-hUSIC 8190 FCR (PG [EA FCR PGM1 0.044 0.044 0.000 0.045 100.000 1M LIMIT
65534 Skystream d... 265 PMT :PGMES... 1 PMT :PGMEBS.. 0.051 0.048 0.000 0.051 100.000 1M LIMIT
BE5534 Skystream d... 720 Private Data [iA Unknown 0.000 0.000 0.000 0.000 100.000 I LIMIT
B5534 Skystream d... | Private Data [HEA Linknown 0102 0.000 0.000 0117 100.000 1M LIMIT
5534 Skystream d T2 Private Data [HiA Linknown 0.000 0000 o.00o 0.000 100.000 1M LIMIT
B5534 Skystream d... T23 Frivate Data A Unknown 0.0o0 0.000 0.0o0 0.0o0 100.000 1M LIMIT
B5534 Skystream d... T24 Frivate Data A Unknown 0.0o0 0.000 0.0o0 0.0o0 100.000 1M LIMIT
B5534 Skystream d... T28 Frivate Data A Unknown 0180 0143 0.0o0 0197 100,000 1IN LIMIT
B5534 Skystream d... T26 Frivate Data A Unknown 0.0o0 0.000 0.0o0 0.0o0 100,000 1IN LIMIT
B5534 Skystream d... T27 Frivate Data A Unknown 0129 0.000 0.0o0 0132 100,000 1IN LIMIT
65534 Skystream d... 728 Private Data IR Linknown 0.000 0.000 0.000 0.000 100.000 1M LIMIT
65534 Skystream d... 729 Private Data [HrA Linknown 0.000 0.000 0.000 0.000 100.000 1M LIMIT
65534 Skystream d... T30 Private Data [HrA Unknown 0.000 0.000 0.000 0.000 100.000 1M LIMIT
5534 Skystream d... A Private Data [HEA Lnknown 0.000 0.000 0.000 0.000 100.000 1M LIMIT
BE5534 Skystream d... 732 Private Data A Lnknown 0.000 0.000 0.000 0.000 100.000 1M LIMIT
5534 Skystream d 733 Private Data [HiA Linknown 0.000 0000 o.00o 0.000 100.000 1M LIMIT
B5534 Skystream d... T34 Frivate Data A Unknown 0.289 0171 0.0o0 0.298 100.000 1M LIMIT
B5534 Skystream d... T3aa Frivate Data A Unknown 0.0o0 0.000 0.0o0 0.0o0 100.000 1N LIMIT
B5534 Skystream d... T36 Frivate Data A Unknown 0.072 0.000 0.0o0 0.081 100,000 1IN LIMIT
B5534 Skystream d... 2305 FCR :PGME A PCR :PGME 0.0o0 0.000 0.0o0 0.0o0 100,000 1IN LIMIT

For each individual PID it is possible to view the minimum and maximum Bitrate since the last reset
(Clear Stats Reset). The columns Min and Max Thresholds can be user configured to provide a
triggered alarm for under or over bitrate conditions per PID, by default these are set to 0 and 100Mb/s

respectively.

25

Note: The PID Monitor is a dynamic view; by clicking the auto refresh button it is

possible to see near instantaneous values for the stream.
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4.6. TEMPLATE CHECK

The template tab offers full customization of the alarms to individual PIDs, and the overall ASI stream.
This tab is divided into 4 different sections for Global Control, Misc Template, Window
Measurements and PID List Template all of which will be described in sections 4.6.1 to 4.6.3.

.H 192.168.11.21, Input [2]: Configuration
|retrest @ @ [ 1.0]|sonty By By

Input Monitor‘l\TS Syntax Errars- P1 & P2 ‘I\TS Syntax Errors - P3 ‘l\ Pid Monitor " Template Check\ Fault Contral ‘I\Trigger Faults \

~Global Control D L
TS BITRATE THRESHOLD PID List Template
TR BT (29E) D Index PID | ExpectedPiDE | il | Present
Max Bitrate (bps) 12 106 wm g E =
3 17 Wwih 1 o
_ 4 20 Wi 2 [
rMisc Templat 5 257 Wit 3 o
Expected Actual i 258 Wil 2 E
T 259 W 3
TS ID Expected 3 g 260 Wik 2 =
9 261 Wihd 2 [
Mum PIDs Expected 46 10 262 Wikl 3 [
1 263 Wwih 1 o
12 265 Uk o
rWindow M rement 13 512 Off ]
Window Measurement 1 {ms) |EDDD | 1; 213 gg =
wilndow Measurement 2 (ms) |SDDD | 1? :: gg =
Window Measurement 3 (s) |30 | 18 a17 off |
18 418 Off (]
20 650 off m
il GO Off [
22 670 Off [
23 6a0 Off (]
24 5490 Cff (]
25 Ton Off [
28 710 Off [
27 720 Off (]
28 721 off m
28 72 Off [
30 723 Off [
M T4 Off (]
12 725 off m
33 726 Off [
34 77 Off (] L4
35 728 Off (]
36 729 off m
37 T30 Off [
38 T3 Off [
38 T3z Off (]
40 733 Cff (]
41 T34 Off (]
42 T35 Off (]
43 736 Off ]
44 2305 Cff (]
45 2180 off m

Figure 4-5: Template Check

4.6.1. Global Control

e Min Bitrate: Enter the minimum transport stream bitrate (bps). If this value is exceeded then a
trap will be sent. Be sure to allow some overhead for natural stream variance.

o Max Bitrate: Enter the maximum transport stream bitrate (bps). If this value is exceeded then a
trap will be sent. Be sure to allow some overhead for natural stream variance.
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4.6.2. Misc. Template

e TS ID Expected: Enter the value for the Transport Stream ID expected, enter zero to disable
the test. A trap will be sent if the card receives a stream with a different value.

g Note: It is not possible to enter the TS ID as a Hex value.

Num PIDs Expected: Enter here the number of PIDs expected in the stream, enter zero to disable the
test. A trap will be sent if the number of PIDs within the stream increases or decreases.

4.6.3. Window Measurement

The window measurement values determine the interval at which each PID (within the PID List
Template) should be expected before an alarm condition is met.

o Window Measurement 1 (ms): Enter a decimal value, measurement is in milliseconds
o Window Measurement 2 (ms): Enter a decimal value, measurement is in milliseconds
o Window Measurement 3 (s): Enter a decimal value, measurement is in seconds

e PID List Template: The PID List Template provides a stream conformance or validation check
with the capability of alarming based on the status of each individual PID in the stream. Here
we can check the presence of each PID using one of the Window measurements as a detailed
above. Depending upon the importance of the PID we can selectively send an alarm if a PID is
missing beyond the measurement window selected.

e Snapshot Live Stream: This button is used to populate the PID List Window with the PIDs
currently found in the stream. Use of this button is slightly different from most normal operations
within VLPro.

o0 Simply click the Snapshot Live Stream button and then the Refresh Configuration View
button; the Snapshot button is automatically applied.

o0 On an operational system ensure you de-select the PID List Template check box before
making a new snapshot, this will avoid alarm conditions being raised as the PID list
changes.

o PID List Template: Once the PID List template has been populated and fully configured, this
check box must be checked to activate the PID List checking.

e Reset PID Template: This button can be used to reset the PID List. All entries will be set to
“NOT SET”, all Windows Measurements (WM) set to “Off” and the Switch Method will also be
set to “Off”. This is useful when changing the switch from one stream to another stream and the
setting will be completely different. Make sure the PID List Template check box is not checked
before resetting to avoid unexpected switching.
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4.7. FAULT CONTROL

The fault control tab is a user configurable tab for enabling or disabling the fault conditions that can be
triggered by the standard ETSI TR 101 290 checks discussed in the previous chapter.

.H 192168.11.21, Input [2]: Configuratio
et @ @ 10 o By B

Input Monitor |, TS Syntax Errors - P1 & P2 ', TS Syntax Errors - P3| Pid Monitor | Template Check ™ Fault Control \Tngger Faults |

P1 Mecessary For Decoding P2 Recommended
TS Sync Errar Transpart Errar
Sync Byte R Error

&

PAT Error

&

PCR Repetition

Continuity Count PCR Accuracy
PMT Error PTS Errar
FID Error CAT Error

P3 DVB Tables P3 ATSC Tables
NIT Repetition v MGT Repetition
MIT Errar v TWCT Repetition
Unreferenced PID v CVCT Repetition
SDT Repetition v ATEC EITO Repetition
SOT Errar v ATEC EIT1 Repetition
CWE EIT Repetition v STT Repetition

[

OWE EIT Error

&

RST Repetition

=l

RST Error

&

TOT Repetition

[&]

TOT Error

Figure 4-6 VistaLINKg PRO Fault Monitor

The four window sub-sections allows users to custom configure which ETSI TR 101 290 test conditions
can trigger an alarm:

Within this tab it is possible to individually de-select (all are selected by default) or later re-select which
tests can produce an alarm condition. The following subsections correspond with the previous Syntax
Error tabs:

P1 Necessary for Decoding
P2 Recommended

P3 DVB Tables

P3 ATSC Tables

It is important to ensure new settings are applied using the apply button on the menu.

Note: DVB/ATSC P3 tests may be greyed out depending on which mode has been
g selected under the Input Monitor Tab (DVB/ATSC or MPEG). ATSC mode will disable
DVB; DVB mode will disable ATSC and MPEG will disable both ATSC and DVB.
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4.8. TRIGGER FAULTS

This tab is divided into two window subsections:
e Trigger Fault Enable: Allows the user to customize the top-level alarms.

o Trigger Fault Status: This section is used as a visual status indicator.

.H 192168.11.21, Input [2]: Configuration
|retresh @ @[ 1.0]| ooy By B

Input Mnnitnr\TS Syntax Errors - P1 & P2 \TS Syntax Errars - P3 \ Pid MDnitDr\Template Check\ Fault Contral | Trigoer Faults \

Trigger Fault Enable Trigger Fault Status

P1 Errars B PF1 Errars

P2 Errors O P2Errors

F3 Errors O P3Errors

Fid Bit Rate [ Pid Bit Rate

Template Errar B Template Errar

Bitrate Below Min Threshald Errar [ Eitrate Below Min Threshald Errar
Bitrate Above Max Threshald Error I Bitrate Above Max Threshold Error
PID Bitrate Below Min Threshald Error [ FID Bitrate Below bin Threshold Errar
FID Bitrate Ahove Max Threshold Error B PIC Bitrate Above Max Threshald Errar
TS 1D Error O TS0 Erar

Mumber Of PID Error [ FID Template List Error

PID Template List Error B Number Of PID Error

Figure 4-7: Trigger Faults
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5. TECHNICAL DESCRIPTION

5.1. SPECIFICATIONS

5.1.1. Inputs and Outputs

2x ASI Input per DVB TR 101 891-270Mb/s Maximum Bitrate 180Mb/s
SD SDI outputs 270Mb/s SMPTE 259M

HD SDI outputs 1.485Gb/s SMPTE 292M

2 x SDI/HDSI output per decoder

TR101290 P1 TR101290 P2
1.1 TS _sync_loss 2.1 Transport_error
1.2 Sync_byte error 2.2 CRC error
1.3 Pat_error 2.3 PCR_error
1.4 Continuity count_error 2.4 PCR_accuracy_error
1.5 PMT error 2.5 PTS error
2.6 CAT error

5.1.2. Decoding Specifications

Video:
SD Encoding
Standard Supported: MPEG-2 Main Profile @ Main Level
Video Format: Standard definition 525 (NTSC) and 625 (PAL)
HD Encoding
Standard Supported: MPEG-2 Main Profile @ High Level
Video Format: HD 720P and 1080l
60Hz and 50Hz
Audio Decoder: MPEG-2 layer 2 decoder x 4 per video decoder

AC3 decoder x 2 per video decoder

Option +422 Decode:
SD: MPEG-2 422 Profile @ Main Level
HD: MPEG-2 422 Profile @ High Level

5.1.3. Embedding of HANC & VANC

Audio Pass Through (AC-3, Dolby E™)
e Closed Caption

5.1.4. Electrical

Power: 65w

5.1.5. Physical
Number of Slots: 3
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6. TROUBLESHOOTING

6.1. VLPRO DOES NOT DISPLAY THE 7880DEC-MP2HD-2 ALARMS

Refer to section 1 to connect directly to the board via the serial port. Once a connection has been
established check and/or configure the SNMP settings with the correct VLPro Server IP address and
ensure the community strings are correctly set. Refer to the network administrator if you are in doubt as
to what these should be set to.

6.2. UPDATING VLPRO SERVER JAR FILE

Products from Evertz are constantly evolving and new features are often added. It is therefore
important to update the JAR files in use to provide access to all the latest features or enhancements. It
will also be necessary to add JAR files for new products. If your new product has not appeared even
after waiting a few minutes for the Ethernet switch negotiation to complete then it is possible that your
JAR file may be old or missing.

To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.

71 VistaLINK PRO Server [:J@
File Toaols el
StatlS Acti\rgte License... bg [ 5 CILein‘\QNCP \m Third Party ".
Flahhorh: Apply Update.. » Product... o
Database: About.. Database.. Description "
DEAdMmIn: U 2007-06-05 Logger Running State setto log events

22:30054  2007-06-058 Completed retrieval of alarm server settings
223084 2007-06-05 Logger Running State setto log events
22:30054  2007-06-05 Retrieving alarm server systern settings
22:30:37  2007-06-05 Starting Datahase

2230037 2007-08-05  Alarm Serder starttup initiated

]
E-rnail Systarm: (5]
MNCP System (&)
MYP Ack System: J
Logging System €9
AutoResponse System: €3
MIE Parsing Support: (L)

License
Expires on 15-06-2007

1 General Clients
2 Plug Clients
-'Weh Clients

- Plus ¥eh Clients

System Statistics

| clear |

Figure 6-1: VistaLINKg PRO Server

A window will appear, as shown in Figure 6-2, simply navigate to the location of the new JAR file and
double click to select the file. The window will automatically close and the update will be applied in the
background.
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a

File  Tools Help

Status

Metwark:

Databasge:

DBAdmIn:

E-mail System:

MNCP System:

MWP Ack Systern
Logaing Systemn:
AutoResponse Systern:
MIE Parsing Support:

License
Expires on 15-06-2007

1 General Clignts
2 Plus Clients

- Wieb Clients

- Plus Weh Clients

Systermn Statistics

Figure 6-2: VistaLINKg PRO — Applying JAR Updates

Server Log | € Clients | &8 NGP | il Third Party),

‘i’a_l Open

Lookln: [E3 WLPRO

) BB EED

IC3 jar Drivers

File pame: |

Files of Type: ‘ Froduct Upgrade Jar(s)

2

| open || cance |

| Clear

You will be prompted to restart the server to enable the change to take effect. Apply as many JAR

updates as required before restarting the server.

25

Please Restart Your Alarm Server

The Alarm Server must he restarted bhefore the product upgrades will be applied.
Flease restart the Alarm Server now.

| Ol

Figure 6-3: “Please Restart Your Alarm Server” Dialog Box

NOTE: You may confirm that all updates have been successfully applied by
selecting from the menu Tools>View>Show/Hide Product update log.

Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is
normal for the startup to take marginally longer while each individual update is being applied. Once
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay
while the update is applied. A prompt will appear confirming that the updates have been applied.

Revision 1.0
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7. ABBREVIATIONS

For the purposes of the present document, the following abbreviations apply:

BAT Bouquet Association Table

BER Bit Error Rate

BW Band Width

CA Conditional Access

CAT Conditional Access Table

CPE Common Phase Error

CRC Cyclic Redundancy Check

ETSI European Telecommunications Standards Institute
DC Direct Current

DvB Digital Video Broadcasting

DVB-C Digital Video Broadcasting baseline system for digital cable television (EN 300 429 [6])

DVB-CS Digital Video Broadcasting baseline system for SMATV distribution systems (EN 300 473
[13])

DVB-S Digital Video Broadcasting baseline system for digital satellite television (EN 300 421 [5])

DVB-T Digital Video Broadcasting baseline system for digital terrestrial television (EN 300 744

[9)

EIT Event Information Table

ETR ETSI Technical Report

ETS European Telecommunication Standard
FEC Forward Error Correction

GOP Group of Pictures

HEX Hexadecimal

ISO International Organization for Standardization
ITU International Telecommunication Union
MGT Master Guide Table

MPEG Moving Picture Experts Group

NIT Network Information Table

PAT Program Association Table

PCR Program Clock Reference

PID Packet Identifier

PMT Program Map Table

PSI MPEG-2 Program Specific Information (as defined in ISO/IEC 13818-1 [1])
PSIP Program and System Information Protocol
PTS Presentation Time Stamps

RS Reed-Solomon

RST Running Status Table (see EN 300 468 [7])
RTE Residual Target Error

SDT Service Description Table

Sl Service Information

TDT Time and Date Table

TOT Time Offset Table

TS Transport Stream

uTC Universal Time Co-ordinated

7880DEC-MP2HD-2 - 36 Revision 1.0



	OVERVIEW
	INSTALLATION
	REAR PLATE DESCRIPTION
	Decoder Connections
	Ethernet Connection

	HARDWARE INSTALLATION
	CONFIGURING THE BASIC NETWORK SETTINGS
	CONNECTING TO VLPRO

	CARD CONFIGURATION
	INPUT SELECT
	PROGRAM TUNING
	Program Tuning

	PROGRAM INFO
	Program Monitor
	Video Monitor
	Audio 1/2/3/4 Monitor

	OUTPUTS
	AC3 Decoder Assignments
	Embedding Audio Source
	Embedding Audio Delay
	Misc. Control

	GENERAL
	MISC FAULTS
	Trap Status
	Trap Enable

	SNMP CONFIGURATION
	Add Trap Destination
	Current Trap Destinations


	CONFIGURING INPUTS
	INPUT MONITOR
	Input Monitor
	Input Control

	TS SYNTAX ERRORS – P1 & P2
	P1 Necessary for Decoding
	P2 Recommended

	TS SYNTAX ERRORS – P3
	P3 DVB Tables
	P3 ATSC Tables
	ETSI TR 101 290 Test Conditions

	TR 101 290 DVB REFERENCE VALUES
	PID MONITOR (+MON OPTION)
	TEMPLATE CHECK
	Global Control
	Misc. Template
	Window Measurement

	FAULT CONTROL
	TRIGGER FAULTS

	TECHNICAL DESCRIPTION
	SPECIFICATIONS
	Inputs and Outputs
	Decoding Specifications
	Embedding of HANC & VANC
	Electrical
	Physical


	TROUBLESHOOTING
	VLPRO DOES NOT DISPLAY THE 7880DEC-MP2HD-2 ALARMS
	UPDATING VLPRO SERVER JAR FILE

	ABBREVIATIONS

